What's Changed

ISO revised the user guide to reflect the following changes:

- Ability to use Word 2016.
- The EFD file name is now a 10 or more character field and matches the ISO Form number.
Contents

What's Changed ............................................................................................................................... i

IMPORTANT NOTICE FOR USERS OF ISO PRODUCTS AND SERVICES .......... 1

Overview ........................................................................................................................................ 2

Product Introduction ....................................................................................................................... 2

ISO Electronic Forms on Disc (EFD) .............................................................................................. 2


Weekly ISOnet Updates .................................................................................................................. 3

Product Support .............................................................................................................................. 3

Symbols Used in This Guide .......................................................................................................... 3

Product Specifications ..................................................................................................................... 4

EFD Files ....................................................................................................................................... 4

EFD File Naming Convention ....................................................................................................... 4

Forms Catalog ............................................................................................................................... 5

Forms Not Included ....................................................................................................................... 5

Technical Specifications ............................................................................................................... 6


Fonts ............................................................................................................................................ 6

Page Breaks ................................................................................................................................ 7

Installation ..................................................................................................................................... 8

Introduction ................................................................................................................................. 8

Installation Procedures ................................................................................................................ 8

Data Decompression for Weekly Update ....................................................................................... 8

Loading Forms for the First Time or Loading an Add-on ................................................................. 8

Windows 2007/2010/2013/2016 .................................................................................................... 8

Installing ISO Forms Add-in .......................................................................................................... 9

System Requirements ................................................................................................................... 9

Installation ................................................................................................................................... 10

After Installing the ISO Forms Add-in ......................................................................................... 10

Troubleshooting ............................................................................................................................ 11

Disable the Add-in ......................................................................................................................... 11

Enable the Add-in ......................................................................................................................... 11

Uninstall the Add-in ........................................................................................................................ 11
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reinstall/Update the Add-in</td>
</tr>
<tr>
<td>Multiple Editions of the Same Base Form</td>
</tr>
<tr>
<td>Interline Forms</td>
</tr>
<tr>
<td>Weekly Update Download</td>
</tr>
<tr>
<td><strong>Customizing ISO Forms</strong></td>
</tr>
<tr>
<td>Filing Requirements</td>
</tr>
<tr>
<td>Paginating the Form</td>
</tr>
<tr>
<td>Keep Lines Together/Keep With Next</td>
</tr>
<tr>
<td>AutoText Entries</td>
</tr>
<tr>
<td>Word 2007/2010/2013/2016</td>
</tr>
<tr>
<td>Inserting an AutoText Entry</td>
</tr>
<tr>
<td>Word 2007</td>
</tr>
<tr>
<td>Word 2010/2013/2016</td>
</tr>
<tr>
<td>Creating AutoText Entries</td>
</tr>
<tr>
<td>Word 2007</td>
</tr>
<tr>
<td>Word 2010/2013/2016</td>
</tr>
<tr>
<td><strong>ISO Forms Add-in Overview</strong></td>
</tr>
<tr>
<td>Introduction</td>
</tr>
<tr>
<td>Forms Add-in Basics</td>
</tr>
<tr>
<td>Opening the Forms Add-in</td>
</tr>
<tr>
<td>Creating a New Document</td>
</tr>
<tr>
<td>Revising a Document</td>
</tr>
<tr>
<td>Opening the Forms Add-in through Microsoft Word</td>
</tr>
<tr>
<td>Overview</td>
</tr>
<tr>
<td>Settings for Word when Using the Forms Add-in</td>
</tr>
<tr>
<td>Track Changes</td>
</tr>
<tr>
<td><strong>Forms Add-in Toolbar</strong></td>
</tr>
<tr>
<td>Overview</td>
</tr>
<tr>
<td>Keyboard Shortcuts and Tooltips</td>
</tr>
<tr>
<td>Button Groups</td>
</tr>
<tr>
<td><strong>Save Group</strong></td>
</tr>
<tr>
<td>Save and Save As Buttons</td>
</tr>
<tr>
<td><strong>Page Setup Group</strong></td>
</tr>
<tr>
<td>Header &amp; Footer Button</td>
</tr>
<tr>
<td>New</td>
</tr>
<tr>
<td>Revise</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Add Line of Business</td>
</tr>
</tbody>
</table>
Viewing a Customer Line of Business .......................................................... 30
Deleting a Customer Line of Business .......................................................... 30
Add Copyright Line ....................................................................................... 30
Viewing a Customer Copyright Line ............................................................ 30
Deleting a Customer Copyright Line ............................................................ 30
Sidebar Button .............................................................................................. 31
Columns Button .......................................................................................... 32
Remove Hyphens Button ............................................................................. 32

**Styles Group** .......................................................................................... 34

Introduction to Styles .................................................................................. 34
  Viewing Styles ............................................................................................ 35
  Outline and Block Styles Overview ............................................................ 36

Block Head Styles Button ........................................................................... 36
Block Text Styles Button ........................................................................... 37
Outline Head Styles Button ....................................................................... 38
Outline Text Styles Button ....................................................................... 39
Demote Styles Button ................................................................................ 40
Promote Styles Button .............................................................................. 40
Other Styles Button .................................................................................... 41

**Insert Group** ........................................................................................ 42

Breaks Button ............................................................................................ 42
  Column Break .......................................................................................... 43
  Page Break .............................................................................................. 43
  Soft Return ............................................................................................... 43
  Continuous Section Break ........................................................................ 43

Symbols Button .......................................................................................... 44
Tables Button .............................................................................................. 45
  Create Table ............................................................................................ 45
  Working with Tables ................................................................................ 46
  Adding Text .............................................................................................. 46
  Adding Rows ........................................................................................... 46
  Adding Columns ...................................................................................... 46
  Changing Column Width .......................................................................... 47

Checkboxes Button ..................................................................................... 48
  Adding a Checkbox .................................................................................. 48
  Resizing an Existing Checkbox ................................................................ 49
  Adjusting the Spacing Between a Checkbox and a Border ...................... 49

Coverages Button ......................................................................................... 50
  Add Coverage Form or Coverage Part ...................................................... 52
Viewing a Customer Coverage Form or Coverage Part ................................................................. 52
Deleting a Customer Coverage Form or Coverage Part ............................................................ 52

Actions Group .......................................................................................................................... 53
  Document Validation Button ............................................................................................... 53
  Document Validation Manual Error Checks ....................................................................... 54
  Fixing Manually Identified Errors .................................................................................... 54
  Document Validation Automatic Fixes ............................................................................ 55
  Create Clean Button ...................................................................................................... 56

Info Group .............................................................................................................................. 57
  Info Button ...................................................................................................................... 57

Appendix – Copyright Statements ......................................................................................... 58
IMPORTANT NOTICE FOR USERS OF
ISO PRODUCTS AND SERVICES

Please make sure that your company has authorized your use of this product and has complied with the requirements applicable in the jurisdiction where you plan to use it.

We distribute both state-specific and multistate products and services. We do not distribute all the multistate products and services for use in every jurisdiction due to corporate policy, regulatory preference, or variations or lack of clarity in state laws.

We provide participating insurers with information concerning the jurisdictions for which our products and services are distributed. Even in those jurisdictions, each insurer must determine what filing requirements, if any, apply and whether those requirements have been satisfied.

Now, as in the past, all of our products and services are advisory and are made available for optional use by participating insurers as a matter of individual choice. Your company must decide for itself which, if any, ISO products or services are needed or useful to its operation and how those selected for use should be applied. We urge that you be guided by the advice of your attorneys on the legal requirements.

Copyright Explanation

The material distributed by Insurance Services Office, Inc. is copyrighted. All rights reserved. Possession of these pages does not confer the right to print, reprint, publish, copy, sell, file, or use same in any manner without the written permission of the copyright owner. Permission is hereby granted to members, subscribers, and service purchasers to reprint, copy, or otherwise use the enclosed material for purposes of their own business use relating to that territory or line or kind of insurance, or subdivision thereof, for which they participate, provided that:

A. where ISO copyrighted material is reprinted, copied, or otherwise used as a whole, it must reflect the copyright notice actually shown on such material.

B. where ISO copyrighted material is reprinted, copied, or otherwise used in part, the following credit legend must appear at the bottom of each page so used:

Includes copyrighted material of Insurance Services Office, Inc., with its permission.

© Insurance Services Office, Inc., 2016
Overview

Product Introduction

ISO Electronic Forms on Disc (EFD)

EFD gives you the ability to produce insurance forms at your workstation. EFD will also free you from maintaining an inventory of paper forms. The forms are stored electronically to allow you to print the forms on demand.


Forms Add-in is provided and supplies extensive authoring capabilities to:

- Append the ISO copyright with your own copyright.
- Add your own company-specific division.
- Add company-specific information.
- Customize the language to produce forms for your own company programs.

Refer to the chapter on Customizing ISO® Forms for filing requirements on modifying ISO forms or using text from ISO forms in creating company-specific forms.
Weekly ISOnet Updates

EFD forms are updated weekly to a customer-specific ISOnet mailbox. The weekly update service provides you with the most current form editions. This service includes weekly ISOnet delivery of the new and revised forms in EFD format for the lines of business and states listed in your purchase agreement. Only the updates that correspond to the lines of business and states detailed in your purchase agreement will be placed in your ISOnet mailbox. You will be notified if no updates were processed for the lines of business you receive.

Product Support

Customer support is provided by the ISO Customer Support Center. Support is available to answer any questions you may have regarding this product Monday through Friday from 7 AM to 12 AM Eastern Standard Time. The telephone number for all area codes is 1(800) 888-4476.

Symbols Used in This Guide

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Note</th>
<th>Reminder</th>
<th>Tip</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Note]</td>
<td>✤ Highlights explanatory comments or additional information.</td>
<td>✤ Repeats directions, definitions or other important information.</td>
<td>✤ Provides a shortcut or alternate method for performing a function.</td>
</tr>
</tbody>
</table>

Note

- Highlights explanatory comments or additional information.

Reminder

- Repeats directions, definitions or other important information.

Tip

- Provides a shortcut or alternate method for performing a function.
Product Specifications

EFD Files

Each EFD file represents one complete ISO form. To access a form after completing the installation procedure, select the appropriate drive and path and double click the form file name. For the list of forms provided, please refer to the readme.txt file found in your EFD delivery.

EFD File Naming Convention

The file names currently correspond directly to the form numbers found on all simplified ISO forms. When updating forms, it is recommended that you keep the naming convention of the original form.

Starting in early 2016, the EFD file name is now a 10 or more character field and matches the ISO Form number.

Prior to 2016, the EFD file names were made up of eight characters while standard form numbers consist of ten characters. ISO had abbreviated all edition dates to resolve this issue.

The edition date of a form, the two characters found in the seventh and eighth positions of a form number, was represented as follows:

- Seventh character = the month. ISO uses the digits 1–9 to represent the months January through September and the letters O, N and D to represent October, November and December, respectively.


Note

- Form numbers found in Commercial Property, Inland Marine, Businessowners, and Personal Lines of business sometimes differ from the format described above. Refer to the readme.txt file to verify all file names and the editions they represent.
Forms Catalog

The forms catalog for each line of business contains hundreds of forms. The number of forms you receive is based on your purchase agreement. With the release of new forms and new editions of forms provided by optional weekly ISOnet update service, the total number of forms in your catalog will change from week to week. Notification of the status of forms is made via ISO circulars. Refer to ISO circulars for information regarding the withdrawal of forms, or refer to the ISO By-state Portfolio.

Withdrawn forms are forms that are no longer in use by the applicable jurisdictions and will no longer be distributed as active forms by ISO. Withdrawn forms will not be removed from ISO electronic forms catalogs and will appear in a historical directory in initial EFD distributions for your reference.

Note

- Applicability information, which identifies the specific jurisdictions in which a form is applicable, is not included with this product.
- As of November 1, 2010, ISO is no longer moving historical forms to histed (historical) directories. All historical forms prior to this date will remain in the histed directory. Forms withdrawn after November 1, 2010 will remain in the active directories.

Forms Not Included

Not all historical versions of Declarations pages are supported. However, paper copies of Declarations pages can be ordered by calling the ISO Customer Support Center at 1(800) 888-4476.
Technical Specifications


The Forms Add-in contains all the styles, macros and AutoText entries used to format all ISO forms and endorsements for all lines of business in EFD. To use Forms Add-in with your Word, you need to install add-in setup on your computer.

Add-in installation setup is included in the Initial order or an Add-on CD. You can also download the setup from EFD Weekly update page on ISONET.

By default the installation program loads Forms Add-in into your computer's program files, which is C:\Program Files\ISO\FormsAddIn.

The Autotext template (FormsAddinAuto.dotm) and supported text files (Copyright.txt, Coverages.txt, LinesOfBusiness.txt) are loaded by the installation program to C:\ISOAPPS\Templates\AutotextTemplate) and to C:\ISOAPPS\Forms\Isofil.es.

EFD has been designed as a single workstation application, though the forms themselves can be stored on a LAN server.

Tip

- If your application requires formatting adjustments, make your adjustments in the Normal.dot template. All features within the Forms Add-in are developed and maintained by ISO.

Fonts

The font used in ISO Electronic Forms on Disc is Arial TrueType in the following sizes:

<table>
<thead>
<tr>
<th>Size</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10-point medium</td>
<td>12-point medium</td>
</tr>
<tr>
<td>10-point bold</td>
<td>12-point bold</td>
</tr>
<tr>
<td>10-point medium Symbol font</td>
<td>18-point bold</td>
</tr>
</tbody>
</table>
Page Breaks

Special attention must be paid to page breaks. Page breaks are used in some EFD forms. However, your print device specifications may require you to adjust these breaks to achieve desired results. Test each form on your print device(s) to verify that pagination has been maintained. Use the Print Preview function to examine pagination on your PC screen.

- Word 2007: Click the Office Button, the arrow next to Print, Print Preview.
- Word 2010/2013: Click on the File tab, Print for Print Preview to appear.
- Word 2016 - Word document appears as part of the Print screen.
Introduction

This section provides instructions on preinstallation and installation procedures for ISO Electronic Forms on Disc.

Note

 To avoid overlaying any files that currently reside on your workstation, read all instructions before you attempt to install EFD.

Installation Procedures

Initial and Add-on orders are on CD, and weekly updates are on ISOnet via a secured mailbox on ISO’s website (http://info.iso.com). The space requirement for EFD will be determined by the number of states and lines of business you order.

For each line of business purchased, the ISO installation procedure will create sub-directories under the ISOFORMS root directory. Only the directories containing forms that are applicable to your ISO purchase agreement will be created.

Once installed, you can manage your files differently by creating your own directories on other drives at your workstation or on a LAN.

Data Decompression for Weekly Update

The installation procedure for updates on ISOnet makes use of the WinZip® Self-extractor program. ISO is licensed to distribute products in WinZip format for the purpose of decompressing files.

Loading Forms for the First Time or Loading an Add-on

The EFD installation program is an InstallShield®-based deployment program, which will be delivered on CD-ROM. Follow these steps to load your ISO forms:


1. Insert disc into CD-ROM drive. (If the install does not start automatically when you insert the disc, begin with Step 2. Otherwise, proceed to Step 5.)
2. From your desktop, open Windows Explorer.
3. Select your CD-ROM drive. The right side of the window will display files.
5. A splash screen will appear. Click Next.
6. The install will begin and you will see a progress bar.

7. Choose your version of Microsoft Word. Click **Next**.
   (If Microsoft Word 2003, the Forms Add-in will not be copied to your machine.)

8. Choose the Forms Add-in Destination Folder
   (default: C:\ISOAPPS\FORMS_Addin)

9. Click **Finish** when completed.

---

**Note**

- The ISO Forms Add-in is compatible with Word 2007/2010/2013/2016. If you are on Word 2003 or lower, the Add-in will not be installed.

The installation program will create your directories and load the files to their respective directories.

After this procedure has been completed, each forms directory created under C:\ISOFORMS will contain a number of forms. The Add-in Setup.exe is copied to C:\ISOAPPS\Forms_Addin.

The installation program will copy the readme.txt and bulletin[date].doc (if there's a bulletin with this release) to C:\ISOFORMS.

- The readme.txt file included in every shipment displays all the forms that appear in each directory. Open this file in Notepad or Wordpad to view the information.

- The bulletin is used to inform customers of any changes and/or replacements to forms or to communicate any needed information.

---

**Installing ISO Forms Add-in**

**System Requirements**

- Windows XP or higher

- Administrator rights are needed on the computer for first-time installations and uninstalls, but generally not for reinstalls/updates.

- Microsoft Office Word 2007, 2010, 2013 or 2016 (32-bit or 64-bit version)

- Internet access

- Prerequisites (any that are missing from your computer will be downloaded and installed):
  - Windows Installer 3.1 (Size: 3 MB)
  - Microsoft .NET Framework 3.5 SP1 (Size: 230 MB)
  - Microsoft Office Primary Interop Assemblies (Size: 7 MB)
  - Microsoft Visual Studio 2010 Tools for Office Runtime (Size: 6 MB)
Installation

To install the ISO Forms Add-in for the first time, you will need to go to C:\ISOAPPS\Forms_Addin. Instructions for installation are as follows:

1. Locate the C:\ISOAPPS\Forms_Addin folder using Windows Explorer.

2. From the C:\ISOAPPS\Forms_Addin folder, double-click on the Forms_Setup.x.x.x.exe file.

3. The Forms Add-in set-up opens to the Select Installation Folder screen.
   a. The temporary installation folder is: C:\ISOAPPS\FORMS_Addin.
   b. You can click Browse… to change the location of the setup files.

4. Click Next.

5. Welcome to the Forms Addin Setup Wizard opens to guide you through the installation. Click Next.

6. The Select Installation Folder screen displays the default install folder (C:\Program Files\ISO\Forms Addin). 
   a. The appropriate folder will be created if it does not exist.
   b. You can click Browse… to change the location of the installed files.
   c. You can click Disk Cost… to view the available space and the required install space for the drives on your computer. Refer to the System Requirements above.

7. Click Next.

8. The Confirm Installation screen opens. If you are ready to proceed with installation, click Next.

9. The Installation Complete screen opens and displays that the Forms Add-in has been successfully installed. Click Close.
   a. If you are an Administrator on the PC, the Forms Add-in is installed for all users. This means you have the option to use this PC as a shared computer.

After Installing the ISO Forms Add-in

1. Verify the following files were copied to C:\ISOAPPS\Forms\isofiles:
   a. Three text files (Copyright.txt, Coverages.txt and LinesOfBusiness.txt)
   b. Save this location for your records. These files allow you to add custom content to the Forms Add-in windows for copyright lines, coverages and lines of business.

2. Also verify the following file was copied to C:\ISOAPPS\Templates\AutotextTemplates:
   a. FormsAddinAuto.dotm

3. Lastly, open Microsoft Word:
   a. Verify that the ISO Forms tab appears on the Ribbon. (If the Add-in tab is not visible in Microsoft Word, go to the Troubleshooting instructions.)
   b. Click on the ISO Forms tab to view the toolbar.
   c. Click on the Info button if you need to verify the date and version number.
Troubleshooting

Disable the Add-in
Follow these instructions if you do not want the Add-in tab to be visible on the Microsoft Word Ribbon. You may want to print these instructions.

1. Open Microsoft Word and click on the Office button (        ) or the File tab.
2. Select the Word Options or Options button at the bottom of the pull-down.
3. Select Add-Ins on the left navigation bar in the Word Options or Options window.
4. Look for the Manage pull-down at the bottom of the window.
5. Select COM Add-ins in the pull-down and click Go…
6. Look for FORMSAddin in the window. Uncheck the checkbox and click OK.
7. Verify that the ISO Forms tab no longer appears in Word.

Enable the Add-in
Follow these instructions if the Add-in tab is not visible on the Microsoft Word Ribbon. You may want to print these instructions.

1. Open Microsoft Word and click on the Office or File button (        ) or the File tab.
2. Select the Word Options or Options button at the bottom of the pull-down.
3. Select Add-Ins on the left navigation bar in the Word Options or Options window.
4. Look for the Manage pull-down at the bottom of the window.
5. Select COM Add-ins in the pull-down and click Go…
6. Select the checkbox next to FORMSAddin in the window. Click OK.
   a. If FORMSAddin was not listed, proceed to step 7.
7. Go back to the Manage pull-down by following steps 1-4.
8. Select Disabled Items in the Manage pull-down and click Go…
9. Look for FORMSAddin in the window.
   a. If it’s there, select it and click Enable. Click Close.
   b. If FORMSAddin was not listed in either the COM Add-ins or Disabled Items windows, follow the instructions above for Installing the ISO Forms Add-in.
10. Verify that the ISO Forms tab appears in Word.

Uninstall the Add-in
You may want to print these instructions.

1. Close all instances of Microsoft Word.
2. Go to Start/Settings/Control Panel/Add or Remove Programs (Windows 7: Start/ Control Panel/Programs/Uninstall). The window may take a few moments to load.
3. Find Forms Addin in the currently installed programs list.

4. Click on it and a Remove button appears. Click **Remove** or **Uninstall**.

5. Click **Yes** when asked if you want to remove the Forms Add-in.

6. The Forms Add-in is no longer in the currently installed programs list. Close the Add or Remove Programs window.

7. Open Microsoft Word and verify that the ISO Forms tab no longer appears.

### Reinstall/Update the Add-in

Follow these instructions to reinstall the Add-in if it is already installed on your machine. You may want to print these instructions.

1. Repeat steps 1-4 in the Installing the ISO Forms Add-in instructions to install the latest version of the Add-in.

2. You are prompted "Prior version of Forms Add-in found. Would you like to upgrade Forms Add-in to a new version?"

3. Click **Yes** to proceed.

4. Welcome to the Forms Addin Setup Wizard opens to guide you through the re-installation. Click **Next**.

5. The Select Installation Folder screen in the wizard displays the default install folder. (C:\Program Files\ISO\Forms Add-in). This folder will be created if it does not exist.
   
   a. You can click the **Browse**... button to change the location of the setup files. (Keep a record of the new location.)
   
   b. You can click the **Disk Cost**... button to view the available space of the drives on your computer. Refer to the System Requirements above.

6. Click **Next**.

7. The Confirm Installation screen opens. If you are ready to proceed with installation, click **Next**.

8. The Installation Complete screen opens and displays that the Forms Add-in has been successfully installed. Click **Close**.
   
   a. If you are an Administrator on the PC, the Forms Add-in is installed for all users. This means you have the option to use this PC as a shared computer.

9. Open Microsoft Word and verify that the ISO Forms tab still appears.

10. Click on the ISO **Forms** tab and click on the **Info** button to verify the date and version number.

### Multiple Editions of the Same Base Form

Your initial delivery may contain more than one edition of a multistate form or endorsement, since newly revised multistate forms and endorsements are seldom effective in all states simultaneously. The delivery may also contain more than one edition of state-specific forms and endorsements to accommodate companies that may have elected to continue using an earlier edition of a form or endorsement. We encourage you to refer to the ISO By-state Sample Forms Portfolios and contact your State Filings department to determine which multistate or state-specific form or endorsement you should use in a given state.
Interline Forms

Interline forms (IL) are used in multiple lines of business. Please be advised that ISO includes each IL form in every line of business to which it applies. If your subscription includes more than one line of business, you can receive multiple copies of an IL form. This type of duplication, if it occurs, is not an error. We encourage you to refer to the Interline Portfolio for Commercial Lines, the Personal Lines By-state Portfolio for personal lines and your State Filings department to determine which multistate IL forms or state-specific IL forms you should use in a given state/LOB combination.

Weekly Update Download

Updates will be provided on ISOnet via a secure mailbox. Each week the forms that have been released since the last update will be placed in customer mailboxes. EFD updates will be tailored to each customer's EFD order.

To access your mailbox, you must first be a registered ISOnet EFD customer. For registration information, please refer to the "New Product Administrator Invitation" email sent when you first ordered EFD.

To download your weekly EFD update:

- Go to [http://info.iso.com](http://info.iso.com).
- Click drop-down box in upper left corner and select EFD Updates.
- Enter Username and Password when prompted.
- Click OK.
- You will see your mailbox with your weekly update.exe, including file date, file name and file size.
- Click the .exe link.
- The file download box will appear.
- Click Run.
- If you receive a WinZip message, click Unzip.

Customers who are getting new forms in this update will see the following window. Defaults are to unzip all files to C:\ISOFORMS\setup and to automatically run the setup.exe.

- Click Unzip on the screen above.
- You will receive a message that the unzip was successful.
• Click OK.

• InstallShield® will launch. Follow the InstallShield directions to run the installation.

The installation program will create your directories and load the files to their respective directories.

After this procedure has been completed, each forms directory created under C:\ISOFORMS will contain a number of forms.

**Note**

- To install the latest version of the Forms Add-in, click the ISO Forms Download link and follow the Installing ISO Forms Add-in instructions in this guide.
- For Win 7 users, you may find when downloading .exe files that you need to click "Run" to allow the files.

The installation program will copy the readme.txt and bulletin[date].doc (if there's a bulletin with this release) to C:\ISOFORMS.

- The readme.txt file included in every shipment displays all the forms that appear in each directory. Open this file in Notepad or Wordpad to view the information.

- The bulletin is used to inform customers of any changes and/or replacements to forms or to communicate any needed information.

Customers who are not getting new forms in this update because there are no newly released forms for the LOBs they subscribe to will see the following screen:

- Click **Unzip** on the screen above.

The installation program will copy the readme.txt and bulletin[date].doc (if there's a bulletin with this release) to C:\ISOFORMS.

**Note**

- There is no **setup.exe** for these customers because there are no forms to install.
Customizing ISO Forms

Filing Requirements

Some of the most frequently asked questions concerning ISO forms libraries concern small changes a company may wish to make to the forms output, and whether or not these changes will require refiling the form with state regulatory authorities. In general, and subject to the laws and requirements of particular states, as long as the text is retained verbatim, including retention of all stylistic formats (e.g., boldface type, indentation, point size, column format), and in sequence, no additional filing procedures are necessary.

Listed below are three items that all or most states do not require refiling:

1. Adding the policy number to the form.
2. Closing up wide top and bottom margins on individual forms to reduce the total number of pages of a form. These wide margins are caused by spacing requirements of the ISO forms that allow us to support various printers requiring different font and line spacing.
3. Line endings for text printed from ISO products that vary slightly from the line endings displayed on paper copies received via mail from our distribution centers. The reason for this variance is discussed in preceding paragraph 2.

Note

- Where required by statute, the 165-line Standard Fire policy must conform to the approved layout of the language for each line of text. If you have any concerns whatsoever about filing procedures, we encourage you to contact either your corporate Legal or State Filings department.

Paginating the Form

The pagination features discussed in this section should be used to improve the appearance of a form.

Keep Lines Together/Keep With Next

All text styles are set with Keep Lines Together turned on. All heading styles are set with Keep With Next turned on. The Keep Lines Together attribute ensures that a paragraph of text does not break across a column or page. The Keep With Next attribute ensures that the heading paragraph stays with the paragraph that follows.

These attributes should not be turned off.
AutoText Entries

AutoText enables you to easily retrieve frequently used text, graphics, etc., and insert them into documents. AutoText ensures that frequently used material is consistent and correct.

Certain functions have already been placed in the AutoText dialog box. You can also add your own entries to this dialog box. You can access this dialog box by doing the following:

**Word 2007/2010/2013/2016**

The AutoText command is not in the Word ribbon, so you must add AutoText to your Quick Access Toolbar.

1. Click the Office Button or File tab and then Word Options or Options.
2. Click Customize or Customize Ribbon.
3. Select Commands Not in the Ribbon under Choose Commands from.
4. Select AutoText.
5. Click the Add button and click OK.
6. Click the AutoText button on the Quick Access Toolbar.

Certain frequently used elements of a form are here. Preview the AutoText entries by clicking on them. The Preview box displays the text of the AutoText entry.

**Inserting an AutoText Entry**

**Word 2007**

1. Place the insertion point where you want the entry to appear.
2. Click the AutoText button on the Quick Access Toolbar.
3. Select the AutoText entry you wish to insert from the General window.

**Word 2010/2013/2016**

1. Click on Insert tab
2. Click Quick Parts and then point to AutoText.
3. Click the entry that you want to insert to your document.

**Creating AutoText Entries**

1. Type the text you wish to store as AutoText. Be sure to include any desired formatting.
2. Select the text. Ensure that all desired text is highlighted. If you want to include paragraph formatting, make sure that the paragraph symbol (¶) is selected too.
Word 2007
1. Click the AutoText button on the Quick Access Toolbar.
2. Click Save Selection to AutoText Gallery.
3. Fill in the fields in the Create New Building Block window, and click OK.

Word 2010/2013/2016
1. On the Insert tab, click Quick Parts, point to AutoText,
2. Click Save Selection to AutoText Gallery.
3. Fill in the fields in the Create New Building Block window, and click OK.

Note
- The Forms Add-in is Read-only. AutoText entries made in a form will not be attached to the Forms Add-in. AutoText entries will be attached to the Normal template.
ISO Forms Add-in Overview

Introduction

After the EFD forms have been loaded, the forms can be printed as is or edited to add policy data before printing. You can also use the Forms Add-in to create a form from scratch. This section provides information on:

- How to access the forms;
- Add-in basics; and
- Customized toolbars.

Forms Add-in Basics

The Forms Add-in is a program that contains document styles, standard text, macros and other customized features for ISO forms. The add-in automates many routine aspects of ISO forms development and standardizes the appearance of forms and endorsements.

The Forms Add-in conforms to ISO Forms Uniformity Standards. Changes to the page setup, such as margins, headers and footers, should not be made.

The Forms Add-in is integrated into Microsoft Word as a tab on the Word ribbon:

The buttons on the Forms Add-in toolbar are explained in the Forms Add-in Toolbar section of this guide.

Opening the Forms Add-in

Creating a New Document

1. Open Word to create a blank Word document.

or

Create a blank Word document from any open Word document.
a. Select the Office Button or File tab → New or click the New button on the Quick Access Toolbar:

b. In the Blank and recent section, select Blank document:

2. Click the Forms tab on the Word ribbon:

3. Click the Header & Footer button to set up the header and footer and apply standard formatting to the document.

The Forms Add-in will not recognize your document until you create a header and footer. You will receive the following error message if you select any other button on the Forms Add-in toolbar prior to the Header & Footer button.

Revising a Document

1. Open a Word document that was created with the Forms Add-in or the FORMS template.
2. Click the ISO Forms tab on the Word ribbon:

Opening the Forms Add-in through Microsoft Word

Overview

The Forms Add-in is built into Microsoft Word as a separate tab on the Word toolbar.

To open the Forms Add-in through Microsoft Word:

1. Open Word.
2. Click the Forms tab located on Word’s ribbon. Forms Add-in customized toolbar displays.
The Forms Add-in toolbar is designed to facilitate creating and editing ISO forms and endorsements. The Forms Add-in toolbar is divided into groups that contain similar commands and functions. Each group along with its commands will be described in detail in subsequent sections of this guide.

**Settings for Word when Using the Forms Add-in**

Various Word settings have been customized to conform with add-in document requirements. Add-in users should not alter their default Word settings.

## Track Changes

Revisions to forms are shown using Word’s **Track Changes** (revision marks) feature. To turn revision marks on or off while editing a document, click the **Track Changes** button on the **Review** tab or on the Quick Access Toolbar located below the ribbon:

With revision marks turned on:

- Material newly added to a form is **underscored**.
- Material deleted from a form is **strikethrough**.
- A revision bar in the left margin indicates a line of text where material has been changed (automatically applied to all lines that contain strikethroughs or underscores).

### Tip

- The keyboard shortcut to toggle **Track Changes** on or off is **Ctrl + Shift + E**.
Forms Add-in Toolbar

Overview

Keyboard Shortcuts and Tooltips

Each button on the Forms Add-in toolbar can be accessed either by clicking the button or through a keyboard shortcut. To view the keyboard shortcut for any button on the toolbar, hover the cursor over the button to display the tooltip. Three components will be displayed:

- Button name
- Alt key + tab code
- Button code

Below are examples of the tooltips for the Header & Footer and Document Validation buttons.

![Header & Footer and Document Validation buttons](image)

Note

- The tooltips instruct you to press F1 for more help, which will launch Microsoft Word’s help feature.

To view the shortcuts for all toolbar buttons at the same time:

1. Press the Alt key to display the tab code for each tab on the ribbon:
2. Type the code for the Forms Add-in tab (**G**) to display the code for each button:

3. When the button codes are visible, you can type the button code to run that command (e.g., **V** for Document Validation).

Tip

- You can hover the cursor over any button on any toolbar in the Word ribbon to display a tooltip.
- Pressing **Alt + tab code** can be used to display the button codes for any tab on the Word ribbon, including native Word tabs such as the **Home** tab (**Alt + H**) or the **View** tab (**Alt + W**).
The following table lists the keyboard shortcuts for the buttons on the Forms Add-in toolbar.

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Alt + G + 1</td>
</tr>
<tr>
<td>Save As</td>
<td>Alt + G + 2</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Alt + G + H</td>
</tr>
<tr>
<td>Sidebar</td>
<td>Alt + G + D</td>
</tr>
<tr>
<td>Columns</td>
<td>Alt + G + C</td>
</tr>
<tr>
<td>Remove Hyphens</td>
<td>Alt + G + R</td>
</tr>
<tr>
<td>Agenda/Minutes</td>
<td>Alt + G + G</td>
</tr>
<tr>
<td>Block Head Styles</td>
<td>Alt + G + B</td>
</tr>
<tr>
<td>Block Text Styles</td>
<td>Alt + G + E</td>
</tr>
<tr>
<td>Outline Head Styles</td>
<td>Alt + G + O</td>
</tr>
<tr>
<td>Outline Text Styles</td>
<td>Alt + G + T</td>
</tr>
<tr>
<td>Demote Styles</td>
<td>Alt + G + M</td>
</tr>
<tr>
<td>Promote Styles</td>
<td>Alt + G + Q</td>
</tr>
<tr>
<td>Other Styles</td>
<td>Alt + G + A</td>
</tr>
<tr>
<td>Breaks</td>
<td>Alt + G + K</td>
</tr>
<tr>
<td>Symbols</td>
<td>Alt + G + S</td>
</tr>
<tr>
<td>Tables</td>
<td>Alt + G + I</td>
</tr>
<tr>
<td>Checkboxes</td>
<td>Alt + G + X</td>
</tr>
<tr>
<td>Coverages</td>
<td>Alt + G + P</td>
</tr>
<tr>
<td>Document Validation</td>
<td>Alt + G + V</td>
</tr>
<tr>
<td>Create Clean</td>
<td>Alt + G + N</td>
</tr>
<tr>
<td>Create HTML</td>
<td>Alt + G + L</td>
</tr>
<tr>
<td>Info</td>
<td>Alt + G + F</td>
</tr>
</tbody>
</table>

For example, to save a form, hold down the Alt key while simultaneously pressing the letter G and the number 1.

Note

- In the tooltips above, a letter other than G may show on your computer.
Button Groups

The Forms Add-in toolbar is divided into six groups of buttons that contain related commands and functions:

The buttons in each group are explained in the following sections:

- **Save**
- **Page Setup**
- **Styles**
- **Insert**
- **Actions**
- **Info**
Save Group

Save and Save As Buttons

Green **Save** and **Save As** buttons are included in the toolbar for all add-ins. Always use the green **Save** and **Save As** buttons (not Word's blue **Save** and **Save As** buttons or shortcut keys) to save your add-in documents.

**Note**

- The green **Save** and **Save As** buttons perform custom, behind-the-scenes save functions for add-in documents that do not occur if you use the Save buttons in native Word. Use only these green buttons to save your Forms documents.
- The green **Save** and **Save As** buttons default to **Word 97–2003 Document (*.doc) [Compatibility Mode]**.
- Do not use .docx or .docm file extensions, which are incompatible file formats for processing add-in documents.
Page Setup Group

Header & Footer Button

The Forms Add-in **Header & Footer** button contains a dynamic pull-down menu with options to create a new header and footer, revise an existing header and footer or delete the header and footer.

**New**

The Add-in **Header & Footer** button will default to New (with the Revise and Delete options disabled) for documents without a header and footer. The Revise and Delete pull-down options will be enabled for selection on documents that already contain a header and footer.

Selecting New will launch the Header & Footer dialog box:

![Header & Footer dialog box](image)

1. Form Number
2. Title
3. Copyright Year
4. Copyright Line
5. Policy Number
6. Endorsement Line
7. Line of Business
8. Copyright Line
9. Copyright Line
10. Copyright Line
1. Form Number

Input the form number you wish to display in the header and/or footer on the form, including edition date (e.g., CA 00 01 03 10). This field is not case sensitive.

Reminder

- Do not use the same base form number for both a state and multistate form: Our systems cannot accommodate this. If this situation already exists, change the base form number on the state-specific form when it is next revised.
- Only state-specific or multistate forms should be created. If a form is being introduced on a limited-state basis, either a multistate form or separate state-specific forms can be created. Limited State forms are not allowed.
- No new multiline forms should be introduced. Only monoline or interline forms should be created going forward.

2. Header/Footer Checkboxes

By default, the form number will be displayed in both the header and footer. Uncheck one or both boxes if you do not want to include the form number in the header and/or footer.

3. Title

The two primary types of titles, and their attributes, can be selected in this section. Select either 18 pt (for Commercial Lines and Personal Lines on the current standards) or 12 pt (for Personal Lines on the old standards). If you need another title size for Policywriting Support Forms, use the Other Styles button to change the style of the title after the header and footer are created.

4. Copyright Year

The copyright year is inserted into the footer of the document based on a four-digit year. To omit the copyright, select the checkbox No Copyright Line to disable the Copyright Line selections.

5. Policy Number

Check this box to insert the words "POLICY NUMBER" in the top left corner of the header on the first page. This option should be used for all Declarations and Schedules that contain fields requiring typing entries.

6. Endorsement Line

Check this box to include the endorsement line statement "THIS ENDORSEMENT CHANGES THE POLICY. PLEASE READ IT CAREFULLY." in the header on the first page of your endorsement.

7. ISO/Customer

The default is set to ISO. Only ISO copyrights and lines of business are displayed. The Customer option allows customers to view a customized list of lines of business and copyrights. The following sections explain how to modify information such as the copyright line and line of business.
8. **Line of Business**
   Select a line of business to be displayed in the header of the form. You can type the first letter of the line of business to jump to that entry in the list box.

9. **Copyright Line**
   Select the appropriate copyright line from the Copyright Line list box. If the copyright line is to be omitted (e.g., for certain Declarations or Schedules), select the checkbox for **No Copyright Line**.

10. **On-screen Help**
    This field displays instructional text based on the field selected within the Header & Footer window. The helper text will change based on different on-screen selections.

**Revise**

The **Header & Footer Revise** option allows you to change the form's header and footer information.

Clicking the **Revise** option will open the Header & Footer window with the previous selections displayed by default:

![Header & Footer window with previous selections](image)
Within the Header & Footer Revise window, users can make the following changes to existing forms:

- Changes to the Form Number
- Changes to the Copyright Year
- Changes to the Line of Business
- Changes to the Copyright Line
- Addition of a Policy Number and Endorsement Line

After making changes in the Header & Footer Revise window, click the OK button to confirm changes. A revised forms document that reflects your changes will then be created.

**Delete**

The Delete option in the Header & Footer button pull-down menu is used to delete headers and footers.

Selecting this option will display the following dialog box:

Click OK to delete all header and footer information.

**Add Line of Business**

When revising a form, you may need to revise the header and footer to amend your own company-specific line of business or indicate a new line of business.

1. Go to C:\ISOAPPS\Forms\isofiles.
2. Open the LinesOfBusiness.txt file.
3. Type in the name of the line of business you wish to add to the Header & Footer window within the Forms Add-in.
**Viewing a Customer Line of Business**

1. Click the **Header & Footer** button (New or Revise).
2. Click on the **Customer** radio button within the **Header & Footer** window. The line of business you entered into the LinesOfBusiness.txt file will be visible in the **Line of Business** pull-down,
3. Click the name of the line of business you wish to insert.
4. Click **OK**.
5. The line of business will be placed into the document header.

**Deleting a Customer Line of Business**

You can delete any unused lines of business by going back to the LinesOfBusiness.txt file on your PC (C:\ISOAPPS\Forms\isofiles) and deleting any item in the list.

**Add Copyright Line**

When revising a form, you may need to revise the footer to amend your own company-added copyright line or append ISO’s copyright line with your company-specific copyright line.

1. Go to C:\ISOAPPS\Forms\isofiles.
2. Open the Copyright.txt file.
3. Type in the name of the copyright line you wish to add to the **Header & Footer** window within the Forms Add-in.

**Viewing a Customer Copyright Line**

1. Click the **Header & Footer** button (New or Revise).
2. Click on the **Customer** radio button within the **Header & Footer** window. The copyright lines you entered into the Copyright.txt file will be visible in the **Copyright Line** pull-down.
3. Click the name of the copyright line you wish to insert.
4. Click **OK**.
5. The copyright line will be placed into the document footer.

**Deleting a Customer Copyright Line**

You can delete any unused copyright line by going back to the Copyright.txt file on your PC (C:\ISOAPPS\Forms\isofiles) and deleting any item in the list.
Sidebar Button

The Sidebar button is used to add text down the right margin of the form that indicates the NEW, REVISED or WITHDRAWN status of the form in a filing. You can also use the sidebar to indicate the following:

- ADVISORY
- DRAFT
- INFORMATIONAL
- NOT FILED
- PROPOSED
- REFERENCE

To add a sidebar:
1. Click the Sidebar button.
2. Select the desired sidebar from the pull-down menu:

3. The sidebar is added to all pages of the form.

To remove the sidebar:
1. Click the Sidebar button.
2. Select None.
3. The sidebar is deleted from all pages of the form.

To change the sidebar:
1. Click the Sidebar button.
2. Select the desired sidebar.
3. The current sidebar is replaced with the selected sidebar.
Note

- After a sidebar has been inserted into a form, the sidebar will not automatically appear on new pages that are added. To fix this, add the sidebar again when you are finished editing the form. Running the Document Validation function will also fix any issues with the sidebar.

Columns Button

The **Columns** button provides a pull-down menu from which you can toggle between a one-column and two-column format. The number of columns in the current section of the document is indicated by a checkmark in the **Columns** pull-down menu.

Note

- You cannot use the **Columns** button if your cursor is positioned in a table.
- This function will change the number of columns in the current section only. If you are at the bottom of a document and wish to change the number of columns from that point forward, insert a Continuous Section Break so that the text of the current section is not changed.

Remove Hyphens Button

The default hyphenation setting in Forms Add-in documents is **None**, meaning that Word does not automatically split the last word in certain lines of text by adding a hyphen between syllables. Prior to January 2010, the hyphenation setting in ISO's forms was **Automatic**.

For older documents, you can use the **Remove Hyphens** button to turn off automatic hyphenation as well as to remove any optional hyphens that may exist in the document. For new and recently revised documents, this function is not needed.

Note

- Optional hyphens (¯) were inserted in certain documents during the conversion from Word 2003 to Word 2007 in order to retain existing line endings and pagination. They are visible in a document only when the Show/Hide ¶ feature is turned on.
To update the hyphenation settings in a document, click the Remove Hyphens button.

- If automatic hyphenation was turned on and/or any optional hyphens are present in the document, the following message will be displayed. Click OK.

![Message: All automatic and/or optional hyphens have been removed from the document.]

You may notice that some lines of text have shifted, and it is possible that text could run over onto another page.

- If hyphenation was already set to None and there were no optional hyphens in the document, the following message will be displayed. Click OK.

![Message: No automatic or optional hyphens were found in the document.]

**Note**

- Automatic hyphenation should always be turned off, except in rare cases when removing automatic hyphenation would result in very large gaps of space between words or if the form has already been filed with automatic hyphenation turned on.

- A check for automatic and optional hyphens is included in the Document Validation function.
Introduction to Styles

A style is a set of predefined formatting characteristics applied to a single stand-alone line of text, paragraph or table cell. In Word, every stand-alone line, paragraph and table cell contains an associated style. When you apply a style to a paragraph, attributes such as font, bolding, spacing and paragraph alignment are changed to match the specifications defined for that style. Using styles ensures consistent formatting of ISO documents and also enables certain features in the electronic product, such as hyperlinks and TOCs (tables of contents).

Note

- When you press Enter (a hard return) to end a paragraph, a nonprinting paragraph mark (¶) appears. Styles are attached to the text in the paragraph and stored in the paragraph mark.
- In Microsoft Word, the default paragraph style is Normal. For Forms documents, the default paragraph style is isonormal. Do not use the Normal style in Forms documents.
- Microsoft Word style names begin with capital letters. Forms style names begin with lowercase letters (except header and footer styles).

The toolbar buttons used to add styles in the Forms Add-in are described in the sections that follow.
Viewing Styles

View or change the style of the paragraph where the cursor is placed using one of the following methods:

- **Style Pull-down**
  The style for the current paragraph is shown in the **Style** pull-down on the Quick Access Toolbar:
  
  ![Style Pull-down](image)

- **Styles Button**
  Click the **Styles** button on the Quick Access Toolbar:

  ![Styles Button](image)

  This will open the **Styles** pane. Scroll down to see the style for the current paragraph, which is identified with a box:

  ![Styles Pane](image)

- **Draft View**
  Change the document view to **Draft** by selecting the **View** tab ➔ **Draft** or by clicking the **Draft** button in the Status Bar at the bottom of the screen:

  ![Draft View](image)

  In **Draft** view, you can view the style for each paragraph in a column on the left side of the screen:

  ![Draft View](image)

  **A. The Cancellation Common Policy Condition is amended as follows:**

  1. Paragraphs 2. and 3. are replaced by the following:

    We may cancel this Coverage Part by mailing to the Named Organization written notice of cancellation, stating the reason for cancellation at least:
If you don't see a list of styles in Draft view, change the size of your style area pane:

1. Click the Office Button or File tab ➔ Word Options (bottom of window) ➔ Advanced ➔ Display section.
2. Change the value for the Style area pane width in Draft and Outline views to any number greater than 0 (e.g., 60 pt):

![Display settings](image)

Outline and Block Styles Overview

The primary styles you will use for text in the Forms Add-in are the outline styles (Outline Head and Outline Text) and block styles (Block Head and Block Text). Each of these style names ends with a number that corresponds to the level of indentation.

- **Outline Styles**
  
  Outline styles (e.g., outlinehd2 and outlinetxt3) are used for paragraphs that are offset by an alphanumeric designator such as G., 1., b., (4), (d) or (ii).

- **Block Styles**
  
  Block styles (e.g., blockhd2, blocktext3) are used for paragraphs that are not alphanumerically designated.

The following text contains examples of two outline styles and one block style:

```
outlinetxt1
outlinetxt2
blocktext3
```

A. The Cancellation Common Policy Condition is amended as follows:

1. Paragraphs 2. and 3. are replaced by the following:

   We may cancel this Coverage Part by mailing to the Named Organization written notice of cancellation, stating the reason for cancellation, at least:

---

**Block Head Styles Button**

The Block Head Styles button is used for caption headings that are not alphanumerically designated.

- Block head styles are left aligned and, when applied to a caption heading, bold.
- There are nine block head styles, with each level indenting the paragraph one position to the right.

To insert a block head style, click the Block Head Styles button and select the appropriate block head level from the pull-down menu:
Example

The text below is an example of the `blockhd2` style:

```
blockhd2
blocktext3
```

Cooperation

You must cooperate with us in all matters pertaining to this policy as stated in its terms and conditions.

---

**Block Text Styles Button**

The **Block Text Styles** button is used for text that is not alphanumerically designated.

- Block text styles are justified and not bold.
- There are nine block text styles, with each level indenting the paragraph one position to the right.

To insert a block text style, click the **Block Text Styles** button and select the appropriate block text level from the pull-down menu:
Example
The paragraphs below are examples of the `blocktext3` and `blocktext4` styles:

<table>
<thead>
<tr>
<th>blocktext3</th>
<th>The &quot;employee benefit plans&quot; (Plans) shown in the Declarations are included as Insureds under Insuring Agreement 1, subject to the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>blocktext4</td>
<td>You are responsible for selecting a Single Loss Limit of Insurance for Insuring Agreement 1. that is sufficient to provide a limit of insurance for each Plan that is at least equal to that required under ERISA as if each Plan were separately insured.</td>
</tr>
</tbody>
</table>

Outline Head Styles Button

The **Outline Head Styles** button is used for caption headings that are preceded by an alphanumeric designator.

- Outline head styles are left aligned and bold.
- The alphanumeric designator must be preceded and followed by a tab for proper alignment of the text.
- There are nine outline head styles, with each level indenting the paragraph one position to the right.

To insert an outline head style, click the **Outline Head Styles** button and select the appropriate outline head level from the pull-down menu:

```
OH
```

Example
The caption heading below is an example of the `outlinehd1` style:

```
Outline  Head  Styles

A. Exclusions

1. Paragraph 2. Exclusions of Coverage A – Bodily Injury And Property Damage Liability is revised as follows:

Note
- Text defined by outline head styles should not be hyphenated (if the automatic hyphenation is turned off). When the outline heading is longer than one line, a line break can be forced, if needed, by using a soft return (`Shift + Enter`).
Reminder

- For outline head and outline text styles, you must press the Tab key to insert a tab before and after the alphanumeric designator.
- To see the tabs in your document, turn on the Show/Hide Paragraph button in the Home tab:
- When paragraph marks are turned on, tabs are displayed as arrows, as shown in the example below:

| Claim-handling Procedures
| 1. Within 15 days after we receive written notice of a claim, we will: |

Outline Text Styles Button

The Outline Text Styles button is used for text that is preceded by an alphanumeric designator.

- Outline text styles are justified, and the default formatting is bold.
- The alphanumeric designator must be preceded and followed by a tab for proper alignment of the text.
- There are nine outline text styles, with each level indenting the paragraph one position to the right.

To insert an outline text style, click the Outline Text Styles button and select the appropriate outline text level from the pull-down menu:

Example

The paragraphs below are examples of the outlinetxt2 and outlinetxt3 styles:

<table>
<thead>
<tr>
<th>outlinetxt2</th>
<th>outlinetxt3</th>
</tr>
</thead>
</table>
| 1. Paragraph 2. Exclusions of Coverage A – Bodily Injury And Property Damage Liability is revised as follows:
Demote Styles Button

The Demote Styles button (arrow pointing to the left) is used to decrease the indentation level of a block or outline style.

To demote a paragraph of text:

1. Position the cursor within the paragraph.
2. Click the Demote Styles button.
3. Click OK at the prompt.

Example

If your paragraph is blocktxt3 and you click the Demote Styles button, the paragraph will retreat one level to blocktxt2 after you click OK at the prompt:

Promote Styles Button

The Promote Styles button (arrow pointing to the right) is used to increase the indentation level of a block or outline style.

To promote a paragraph of text:

1. Position the cursor within the paragraph.
2. Click the Promote Styles button.
3. Click OK at the prompt.

Example

If your paragraph is outlinehd3 and you click the Promote Styles button, the paragraph will advance one level to outlinehd4 after you click OK at the prompt:

You cannot advance beyond nine levels.

Tip

You can highlight multiple paragraphs of the same style to promote or demote several paragraphs at once. All highlighted paragraphs must be the same style.
The **Other Styles** button opens a pull-down menu containing all Forms Add-in styles that are not included in another button in the **Styles** group. All styles other than block, outline and linking styles can be accessed using the **Other Styles** button pull-down menu:

<table>
<thead>
<tr>
<th>Styles</th>
<th>Styles</th>
<th>Styles</th>
</tr>
</thead>
<tbody>
<tr>
<td>center</td>
<td>section</td>
<td>tablebd dec page</td>
</tr>
<tr>
<td>colline</td>
<td>section title center</td>
<td>TEXT12</td>
</tr>
<tr>
<td>column heading</td>
<td>section title flush left</td>
<td>TEXT14</td>
</tr>
<tr>
<td>column heading12</td>
<td>space2</td>
<td>TEXT16</td>
</tr>
<tr>
<td>column heading14</td>
<td>space4</td>
<td>TEXT18</td>
</tr>
<tr>
<td>column heading16</td>
<td>space0</td>
<td>TEXT24</td>
</tr>
<tr>
<td>column heading18</td>
<td>tablerow2</td>
<td>title flush left</td>
</tr>
<tr>
<td>column heading24</td>
<td>tablerow4</td>
<td>title12</td>
</tr>
<tr>
<td>isonormal</td>
<td>tabletext</td>
<td>title14</td>
</tr>
<tr>
<td></td>
<td>tabletext8</td>
<td>title16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>title18</td>
</tr>
<tr>
<td></td>
<td></td>
<td>title24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>title30</td>
</tr>
</tbody>
</table>
Insert Group

Breaks Button

The **Breaks** button provides the option to insert several types of breaks into a form:

- Column Break
- Continuous Section Break
- Page Break
- Soft Return (line break)

To insert a break:

1. Position the cursor at the beginning of the paragraph where you want to start the next column, section, page or line.
2. Click the **Breaks** button.
3. The **Breaks** pull-down menu is displayed.
4. Select the option you would like to insert.

Tip

- You can also insert breaks using the keyboard shortcuts indicated in the **Breaks** button pull-down menu.

An explanation of each type of break follows.
Column Break

A column break is the point in text where one column ends and the next begins. Word automatically aligns columns on the pages, but you can insert a hard column break if you would like the second column to begin in a different place. Using hard column breaks also aligns the text at the top of each column.

Note

- Column spacing must be 24 pt (1/4 of an inch). If a form was created with an old version of the Forms template, it may not contain proper column spacing. Check this by clicking the Page Layout tab → Page Setup group → Columns → More Columns.

Page Break

Word automatically inserts "soft" page breaks based on the amount of text that will fit within the document margins, adjusting the pagination as necessary when text is added or deleted. You can also insert a page break manually if you would like the page to break at a particular place. These page breaks are termed "hard" because they do not change unless you move or remove them. When you insert a hard page break, Word adjusts the soft page breaks that follow.

Soft Return

Word automatically wraps text at the end of one line onto the next line in a paragraph. Soft returns can also be manually entered into a Word document to break a line of text at a particular location. They are shown as left-facing arrows when the Show/Hide feature is turned on.

Continuous Section Break

At the end of a section or a document, you may find that the text is not evenly distributed among columns. Balancing columns on a page is most often used on the last page of a form so that a long left column is realigned into two proportional columns. You can balance the text between columns by inserting a continuous section break at the bottom of the last column, which distributes the text evenly so that a new section can begin on the same page.

Continuous Section breaks are also used:

- After the Form title
- To separate a one-column section from a two-column section
Symbols Button

Use the Symbols button to add symbols, bullets or special nonprinting characters to your document. Select a symbol from the following options in the Symbols pull-down menu to place that symbol at your insertion point:

- Asterisk
- Box
- Bullet
- Copyright
- Dagger
- Diamond
- Division
- En Dash (Ctrl + Minus on numeric keypad)
- Nonbreaking Hyphen (Ctrl + Shift + Hyphen)
- Nonbreaking Space (Ctrl + Shift + Space)
- Registered
- Section
- TM Trademark

- The following symbols will create a bulleted list:
  - Bullet
  - Diamond
  - Box

- Use a nonbreaking hyphen in place of a standard hyphen to prevent the separation of hyphenated text if the text falls at the end of a line.

- Use a nonbreaking space in place of a standard space to prevent the separation of text if the text falls at the end of a line. For example, to prevent a form number such as AG 12 01 from being split across lines, use nonbreaking spaces after AG and 12: AG®12'01

Note
- Always use the Symbols button in the Forms Add-in, not in native Word.
Tables Button

Word table functions are used to create Schedules and other entry information in ISO forms and endorsements. The Forms Add-in contains a customized version of Word's Table commands. This customized version conforms to ISO Forms Uniformity Standards and ensures that border and table widths fit within the form's margins.

Create Table…

1. Position the insertion point where you want to add a table.
2. Click the Tables button.
3. The following pull-down options appear:

4. Click Create Table.
5. The following window appears:

![Create Table Window]

**Note**
- The Table width automatically defaults to 504 pt or 240 pt based on whether you are inserting the table in a one-column or two-column section of the form.

6. Enter the number of columns and rows.
7. Click OK to create the table.

**Note**
- A blank paragraph is inserted above the table.
- All cells are styled as `tabletext`.


Working with Tables

Adding Text
- You can add, delete and format text in a cell just as you would in any paragraph of text.
- To add text in a table, click in any cell. The insertion point appears next to the end-of-cell mark.
- The height of a cell increases as you add text.
- To move from cell to cell in a table, press the Tab key, or use the arrow keys.
- All text in a table must be formatted with a table style.

Adding Rows
To add rows to a table, do one of the following:
1. Position the insertion point in the bottom right corner of the cell and press the Tab key.
   or
2. Position the insertion point just outside the right border of a table row and press the Enter key.

Adding Columns
To add columns in a table, use Word's Split Cells function (not the Columns function).
1. Position the insertion point in the column where you want to add the new column.
2. Right-click in the cell.
3. Select Split Cells…
4. Enter the number of columns in the Split Cells dialog box:

![Split Cells dialog box]

5. Click OK.

Reminder
- Do not use the Columns function in native Word to insert a column. This will alter the integrity of the table margins.
Changing Column Width

To change the column width in a table:

- Position the mouse pointer on the vertical gridline of the column you want to adjust. When the cursor changes to arrows pointing left and right, drag the gridline to the left or right.

  or

- Point to the table column marker on the ruler above the vertical gridline of the column you want to adjust. Hold down the mouse button and then drag the table column marker to the left or right.

Whether you drag a gridline or a column marker, all columns to the right are resized in proportion to their original width. The overall width of the table does not change.

Note

- Do not drag the right or left border of the table. The table should extend the full width of the column.
Checkboxes Button

Use the Checkboxes button to create a standard-size checkbox in a table cell. The Checkboxes button will insert up to four checkboxes or adjust the size of an existing checkbox.

Example

- Yes
- No

Adding a Checkbox

1. Position the cursor in the table cell in which you would like to create one or more checkboxes. This cell must be blank and must be wide enough to fit the desired number of checkboxes.

2. Click the Checkboxes button.

3. The following pull-down menu appears:

4. Select 1, 2, 3 or 4 checkboxes.

5. This function will:
   - Split the cell into the appropriate number of columns, including a spacer cell at the left border.
   - Adjust the row height to 14.3 pt, which is the standard row height for tables in a form.
   - Add borders to the appropriate cell(s) to create the checkbox(es).
   - Set the alignment in the checkbox cell(s) to Center.

Note

- Checkboxes must be added to tables and cannot be added to text.
Resizing an Existing Checkbox

1. Highlight the checkbox you wish to resize.
2. Select the **Checkboxes** button.
3. The following pull-down menu appears:

4. Click **Resize Checkbox**.
5. This function will:
   - Adjust the row height to 14.3 pt, which is the standard row height for tables in a form.
   - Adjust the column width to 14.3 pt.
   - Resize columns to the right of the checkbox if necessary to fit the table width.
   - Add borders to the cell if they do not already exist.

Adjusting the Spacing Between a Checkbox and a Border

If space is available, use the `tablerow2` or `tablerow4` style to add space between a checkbox and a horizontal table border. For example, in the following table:

<table>
<thead>
<tr>
<th></th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>

Adding a row styled `tablerow4` above and below the row containing the checkboxes would produce the following table:

<table>
<thead>
<tr>
<th></th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>
Coverages Button

Use the **Coverages** button for endorsements in which applicable Coverage Forms or Coverage Parts are specified. For example, the following text can be inserted using the **Coverages** button:

This endorsement modifies insurance provided under the following:

BUSINESSOWNERS POLICY
COMMERCIAL AUTO COVERAGE PART
FARM COVERAGE PART

To use the **Coverages** button:

1. Position your insertion point before the second paragraph mark of the document (at the beginning of the line after the Form title).

2. Click the **Coverages** button and two options appear in the drop down:
   a. Add Coverages
   b. Sort Selected

3. To add Coverages, select **Add Coverages** option and the following dialog box will appear:
   a. Click the name of each Coverage Form or Coverage Part you wish to insert. Click the name of a Coverage Form or Coverage Part again to deselect that coverage.
   b. Click **OK**.
   c. The Coverages you added will be placed alphabetically into your form.

4. To alphabetize the Coverages:
   a. Highlight the listed Coverages and click on **Sort Selected**.
b. Select OK.

c. The list is sorted alphabetically. If any duplicates are present, they will be removed.

Note

- The style for Coverage Form or Coverage Part is **blockhd2**. This style normally has boldface text. However, when you access the **Coverages** button, the text will be lightface.

- If you have selected Coverages styled with a style other than blockhd2 or selected only one Coverage when using **Sort Selected**, an error message will appear.

- If the endorsement already contains a list of Coverage Forms or Coverage Parts, any new Coverage Form or Coverage Part added using the **Coverages** button will be added to the end of the list. You will need to use the **Sort Selected** option to alphabetize.
Add Coverage Form or Coverage Part

If the Coverage Form or Coverage Part you need is not on the list, you can add it to the list by typing the Coverage Form or Coverage Part in the Coverages.txt that is installed on your PC with the Forms Add-in.

1. Go to C:\ISOAPPS\Forms\isofiles.
2. Open the Coverages.txt file.
3. Type in the name of the Coverage Form or Coverage Part you wish to add to the Coverages window within the Forms Add-in.

Note
- You cannot revise or delete Coverage Forms or Coverage Parts using the Coverages button.

Viewing a Customer Coverage Form or Coverage Part

1. Position your insertion point before the second paragraph mark of the document (at the beginning of the line after the Coverage Form or Coverage Part).
2. Click the Coverages button.
3. Click on the Customer radio button. The Coverage Form or Coverage Part you entered into the Coverages.txt file will be visible in the window.
4. Click the name of each Coverage Form or Coverage Part you wish to insert. Click the name of a Coverage Form or Coverage Part again to deselect that coverage.
5. Click OK.
6. The Coverage Form or Coverage Part will be placed alphabetically into your form.

Deleting a Customer Coverage Form or Coverage Part

You can delete any unused customer Coverage Form or Coverage Part by going back to the Coverages.txt file on your PC (C:\ISOAPPS\Forms\isofiles) and deleting any item in the list.
Actions Group

Document Validation Button

The Document Validation process ensures that valid formatting and styles have been used in a forms document. After the forms document has been revised, Document Validation is performed to verify correct styles, formatting and settings throughout the document.

The Document Validation Results pane provides an error report that categorizes errors as either manual fix or automatically fixed items. Errors identified for you to fix manually are shown on the top half of the Document Validation Results pane, while errors that the Document Validation function has already fixed automatically are identified in the bottom half of the window.
Document Validation Manual Error Checks

Document Validation will perform the following checks and will alert the user if the following checks fail. The user should fix these errors manually.

- Automatic hyphenation and optional hyphens
- Simplified boxes
- Appropriate styles
- Appropriate font size
- Appropriate tabs in outline styles

Note

- The Document Validation function verifies that the styles you have used are those defined in the Forms Add-in. If the style used does not match the customized styles in the Forms Add-in, the style is highlighted and a dialog box is displayed giving you an opportunity to correct the style.

Fixing Manually Identified Errors

If an error is identified during the Document Validation process as an error to fix manually, perform the following steps to fix each error:

1. Double-click within the Document Validation Results pane. Document Validation highlights the error within the document.

Note

- Double-clicking an item in the Document Validation Results pane will place a check in the checkbox next to the item.

Example

![Image of Document Validation Results pane]

<table>
<thead>
<tr>
<th>#</th>
<th>Error Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Simplified box found in the footer.</td>
</tr>
<tr>
<td>2</td>
<td>Normal is not a valid style in Forms standard</td>
</tr>
</tbody>
</table>
2. Fix the error if necessary.

3. Perform the same steps to fix the remaining errors.

4. Click **Rerun** until no more errors are generated and a prompt displays that Document Validation has completed.

   **Note**
   - Manual fixes require users to double-click on each error found within the **Document Validation** pane.
   - When users double-click **Automatic Hyphens/Optional Hyphens** or a simplified box, an error prompt will appear. You may choose to ignore these errors if applicable.

### Document Validation Automatic Fixes

Document Validation also automatically fixes certain errors within a document. Below is a list of the errors that Document Validation will automatically fix:

- Sidebar issues
- Table width
- Styles of section breaks
- Style at the end of each table row
- Page margins
- Em dashes in title styles
- Column width
Create Clean Button

The **Create Clean** function can be used to do the following:

- Accept all revisions in the document.
- Turn off Track Changes if this option is on.
- Remove all sidebars in the document.

The above actions can be performed separately or by using the **Create Clean** function:

1. Click the **Create Clean** button.
2. Click **Yes** when the following dialog box is displayed:

   ![Create Clean Dialog](image1)

3. Click **OK** when the following message is displayed:

   ![Create Clean Message](image2)

If the form does not contain sidebars or tracked changes, the following message is displayed:

![Create Clean Message](image3)
Info Group

Info Button

The **Info** button displays information about the Forms Add-in:

![Info Window]

**About**

The About section provides the version number and date of the Forms Add-in installed on your computer. Check this section to verify that you are using the latest version of the Forms Add-in.
### Appendix – Copyright Statements

<table>
<thead>
<tr>
<th>Copyright Statement</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>© Insurance Services Office, Inc., XXXX</td>
<td></td>
</tr>
<tr>
<td>Copyright, Hawaii Insurance Bureau, Inc., XXXX</td>
<td></td>
</tr>
<tr>
<td>Includes copyrighted material of Insurance Services Office, Inc., with its permission.</td>
<td></td>
</tr>
<tr>
<td>Copyright, Idaho Surveying and Rating Bureau, Inc., XXXX</td>
<td></td>
</tr>
<tr>
<td>Includes copyrighted material of Insurance Services Office, Inc., with its permission.</td>
<td></td>
</tr>
<tr>
<td>Copyright, Insurance Rating Bureau of the District of Columbia, Inc., XXXX</td>
<td></td>
</tr>
<tr>
<td>Includes copyrighted material of Insurance Services Office, Inc., with its permission.</td>
<td></td>
</tr>
<tr>
<td>Copyright, North Carolina Rate Bureau, XXXX</td>
<td></td>
</tr>
<tr>
<td>Copyright, North Carolina Rate Bureau, XXXX</td>
<td></td>
</tr>
<tr>
<td>Includes copyrighted material of Insurance Services Office, Inc., with its permission.</td>
<td></td>
</tr>
<tr>
<td>Copyright, Property Insurance Association of Louisiana, XXXX</td>
<td></td>
</tr>
<tr>
<td>Copyright, Property Insurance Association of Louisiana, XXXX</td>
<td></td>
</tr>
<tr>
<td>Includes copyrighted material of Insurance Services Office, Inc., with its permission.</td>
<td></td>
</tr>
<tr>
<td>Copyright, Washington Surveying and Rating Bureau, Inc., XXXX</td>
<td></td>
</tr>
<tr>
<td>Includes copyrighted material of Insurance Services Office, Inc., with its permission.</td>
<td></td>
</tr>
</tbody>
</table>